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1. Activation 

Activation using Windows  

Upon starting HDR projects 7 for the first time, you will be prompted 

to activate the program. Proceed as follows:  

Install HDR projects 7 as described by the installation instruc-

tions.    

Input your serial number. For the box version, this can be found on 

the accompanying booklet. If you have chosen to download the 

program, you will find the serial number in your customer account 

at www.franzis.de. 

 

Finally, click on the “Activate” button. The software has now been 

successfully activated! 

 

Activation using Mac  

Upon starting HDR projects 7 for the first time, you will be prompted 

to activate the program. Proceed as follows:  

Install HDR projects 7 as described by the installation instructions.    

http://www.franzis.de/
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Input your serial number. For the box version, this can be found on 

the accompanying booklet. If you have chosen to download the 

program, you will find the serial number in your customer account at 

www.franzis.de. 

 

Finally, click on the “Activate” button. The software has now been 

successfully activated!  

Note: HDR projects 7 can be installed on up to two comput-

ers using the same serial number.   

A second serial number is not required. When installing the pro-

gram on a second device, simply enter the serial number again 

and press “Activate”.   

 

http://www.franzis.de/
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2. Fascinating High Dynamic Range Photog-

raphy 

Even the most modern digital cameras have a limited dynamic 

range. Drastic lighting contrasts exhibit this restriction easily, such 

as with a photo taken indoors looking outside, like in the first exam-

ple shot. You either have a properly lit interior, where the surround-

ing park behind the arches are far too bright, or an image with an 

adequately lit park, but with an interior that is far too dark.   

HDR technology, short for High Dynamic Range, clears up this 

problem by generating images with an extremely large dynamic 

range, unmatchable by monitor displays or prints.  

The idea is simple - several images with varying exposure times are 

assembled into one image. In our example, three shots are fused: 

an image with a longer exposure time to capture the dark details 

inside the pavilion, a short exposure shot where the park behind the 

pavilion is correctly lit, as well as an exposure exactly in the middle.     

The combined result is a single image containing all of the light, 

midtone and shadow detail. HDR projects 7 does the work for you. 

The capable program merges the bracketing exposure images and 

uses tone mapping to establish a photo fit for printing and screen 

displays. 
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The combined image contains all of the details of the pavilion and 

park, properly lit just as we saw the scene with our own eyes.    

In the next few pages we will show you how quickly you can create 

fascinating images with HDR projects 7 and what you can achieve 

with its immense range of functions.   

An obvious case for HDR projects 7 - an evening scene with lan-

terns can only be captured naturally using HDR technology. Other-

wise, the dark surroundings would not be capturable with the bright 

lights. A camera sensor's range of contrast is very limited when 

compared to that of the human eye.      
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All of the details are realistically depicted in the fused photo.   

 

Tip: Always capture your bracketing series with different exposure 

times and not just with different blending values. Merging the imag-

es requires an identical depth of focus for all of the individual shots. 
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3.  What´s New? 

HDR projects 7 offers many new features. Here is a summary of 

some of the most important developments: 

 

 New ultra-HDR mode „Highlight Boost”: The standard 

activated ultra-HDR mode „Highlight Boost” creates more 

realistic HDR-pictures. Especially tricky lighting conditions 

can be mastered with the new mode. It helps to bring even 

the finest details in your images to life – details such as 

hair structure, for example. 

Originalimage               „Highlight Boost“                

 

 5 presets for the HDR-weight-distribution: For calculat-

ing the HDR-weight-distribution the program offers 5 dif-

ferent exposition (exposure bracketing) methods. The 

standard setup is the denoising technique (“midtones dom-

inate”). 

 

 New tonemapping: The new tonemapping „Retina” offers 

colour fidelity and a „tonal value” which matches the hu-
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man eye’s colour perception. It is particularly suitable for 

pictures with high contrast. To access „Retina” in the Post-

Processing-Mode, simply enter “expert” in the search bar 

                              

Originalimage                      Tonemapping „Retina“  

 

 Add-on to the HDR-Styles: The tonemappings (Colour fi-

delity & Retina) support the HDR-Styles as well.  

 

 Improvement of the automatic image alignment by the 

use of options such as:  

- Landscape 

- Nebula, night sky 

- Soft motifs (strong bokeh) 

 

 New Presets: 

- 21 new Presets  

- New category „grunge“  10 presets 

- New category „microdetails“  11 presets 
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 4 New Smart-Mask-Filter: Smooth areas, midtones, gra-

diation, vignette 

 

 New „colour filter“ module in selective drawing: 8 dif-

ferent colour filters (red, orange, yellow, green-yellow, 

green, cyan, blue, violet)  

 Add-ons in selective drawing:  

- Adjustable contrast and colour saturation of the compos-

ing-pictures 

- Bool’sche functions to combine masks 

- Perspective tilting of textures 

- Adjustable texture-calculation- quality-tools in 3 levels 

- Automatic  construction of crossfaded texture-databases 

- Mulitple UnDo & ReDo of the paintbrush-tool 

 

 Select a font: Select one of the installed and compatible 

fonts according to your own personal preference. In addi-

tion to the font size, you now have the possibility to create 

an individual working space with your entire user interface 

displayed in the font of your choice. 

 

 Add-on to the scratch- and sensor-correction: 5 new 

quality modes for searching for corresponding areas au-

tomatically. 
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 Additional external programs: up to 12 external pro-

grams and their configurable names.  

 

 Scaled saving of images: A new sub-module in image 

cropping allows you to save images in a smaller size. This 

also includes around 30 templates for various platforms in-

cluding Facebook, YouTube and Instagram as well as pix-

el-precise input of image formats. 

 
 18 New layer processing methods in HSV and HSL col-

our spectrums 

 Notes in the undo-timeline 

 
New Automations:  

 Automatic File Save with or without cropping edits  

 Automatic File Save in maximum resolution   

 Automatic Grain Engine reset capabilities  

 Information dialogues display on/off  

 Automatic Denoise Optimisation on/off  

 

New RAW-Formats: 

 

 Apple iPhone 8(*), iPhone 8 plus, iPhone X 

 BlackMagic URSA Mini 4k, URSA Mini 4.6k, URSA Mini Pro 4.6k 
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 Canon PowerShot A410, A480, A540, D10, ELPH 130 IS, ELPH 

160 IS, SD750, SX100 IS,SX130 IS, SX160 IS, SX510 HS, SX10 

IS, IXUS 900Ti, PowerShot G1 X Mark III, G9 X Mark II, EOS 6D 

Mark II, EOS 77D, EOS 200D, EOS 800D, EOS 2000D, EOS 

4000D, EOS M6, EOS M100 

 Casio EX-ZR4100/5100 

 DJI Phantom4 Pro/Pro+, Zenmuse X5, Zenmuse X5R 

 Eyedeas E1 

 FujiFilm S6500fd, GFX 50S, GFX 50R, XF10, X100f, X-A3, X-A5, 

X-A10, X-A20, X-E3, X-H1, X-T3, X-T20, X-T100, DBP680 

 GITUP GIT2P, G3 DUO (16:9 only) 

 Hasselblad H6D-100c, A6D-100c 

 Huawei P9 (EVA-L09/AL00), Honor6a, Honor9, Mate10 (BLA-L29) 

 Kodak PIXPRO, AZ901 

 Leica CL, M10, M10-D, M-10P, TL2 

 LG V20 (F800K), VS995 

 Nikon D850, D3500, D5600, D7500, Coolpix B700, Z6, Z7, P1000 

 Olympus E-PL9, E-M10 Mark III, TG-5 

 OnePlus One, A3303, A5000 

 Panasonic DMC-FZ45, DMC-FZ72, DC-FZ80/82, DC-G9 (std. res 

mode only), DC-GF10/GF90, DC-GH5, DC-GX9, DC-

GX800/850/GF9, DMC-LX1, DC-ZS70 (DC-TZ90/91/92, DC-T93), 

DC-TZ100/101/ZS100, DC-TZ200/ZS200, LX100M2 

 PARROT Bebop 2, Bebop Drone 

 Pentax KP, K1- II 

 PhaseOne KP, K1- II 

 Samsung Galaxy Nexus, Galaxy S3, S6 (SM-G920F), S7, S7 

Edge, S8 (SM-G950U) 
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 Sony A7R III, A7 III, A9, DSC-RX0, DSC-RX10IV, HX95, HX99, 

RX100-VA, RX-100VI 

 Yi M1 

 YUNEEC CGO3, CGO3P 

 Xiaoyi YIAC3 (YI 4k) 
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4. Configuring the User Interface 

Optional font size for menus and titles 

In the program´s main menu, clicking View  Font size will provide 

you the option to customise the size of the letters in the menu as 

well as in the titles of the program. 

 

The font size can be adjusted to the run time of the program.  

4K – monitors gives you the option to enlarge the font size for 

better readability of the menu. 

 

Select a font 

HDR projects 7 offers you the opportunity to designate a suitable 

font of your preference. You will find a selection of the installed and 

compatible fonts in View  Font, simply pick your favourite. 
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If you want to change the font back to standard select View  Font 

 reset font. 

 

 

 

 



HDR projects 7 – User manual 

 

17 

5. HDR Photos Done Quickly 

You can obtain a finished HDR image in just 5 clicks with HDR pro-

jects 7.    

1. Load Images   

2. HDR Preparation  

3. Post-Processing  Select HDR Style   Preset Selection   

4. Set the optimisation assistant   

5. Select Image segment and Save, that´s it! 

 

You can simply drag and drop your images or bracketing series onto 

the start screen. 

 

How to get the results you want, and fast - the elaborated presets 

and looks, individual image adaption and selected drawing allows 

you to go down your own creative route. HDR projects 7 offers 

both options.    
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At the top of the screen are the main menu as well as the menu bar. 

This menu bar contains the following functions (from left to right): 

 

o Exposure bracketing browser   

 

o History viewer      

 

o HDR from a single image     

 

o Import exposure bracketing    

 

o Open project      

 

o Batch processing (HDR + tonemapping)   

 

Optionally, image data may also simply be „dropped” onto the 

screen by Drag & Drop. The image data is then uploaded automati-

cally. 
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6. Importing Image Material 

 

To load a single image or a bracketing series, simply drag and drop 

the images onto the start screen. Alternatively, you can also use the 

toolbar buttons or drop-down file menu.    

 

 

The maximum number of possible exposures of a bracketing 

series is 19 pictures in HDR projects 7. 

 

How does this number come about? 

A HDR- photograph (High Dynamic Range) differentiates from other 

photographs through one major characteristic: 

The information of 32 exposure levels (32 Bit/ 32 ev) can be saved 

in one image. 

These 32 exposure levels (32 Bit/32 ev) are made up of the accura-

cy of RAW images with 14 exposure levels (14 Bit/ 14 ev) as well as 

the exposure differences throughout the bracketing series. 

Let´s take for example a bracketing series that was taken with -2ev, 

0ev, and +2ev. Which has as a result the dynamic range of +2-(-2) = 

4 ev as exposure difference. This plus the 14 exposure levels from 

RAW, has a total of 18 ev exposure levels (18 Bit/18ev). 

55 Images are already sufficient to exactly replicate a bracketing 

series from -9 ev to +9 ev with intervals of 1/3 ev between two im-
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ages. This ensures that you have used the maximum exposure that 

you can get out of a very good camera. 

Adjusting the +/- exposure value controls on your camera to posi-

tive/negative values will allow you to generate additional exposures 

for your standard exposure bracket.  

The HDR preparation dialog will open as soon as an image or a 

bracketing series has been selected or dragged and dropped into 

the program. 

Here you can choose if you want to see the dialog each time you 

upload a bracketing series (click on the box at the bottom). 

 

 

 Exposure bracketing browser 

For a better overview of your bracketing series you can 

use the exposure bracketing browser before uploading 

your bracketing series. 

Click on the corresponding symbol in the task bar. A pre-

view window will open. Chose by „quell folder” your expo-

sure bracketing browser folder. 
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HDR projects 7 starts immediately with the calculation, fitting au-

tomatically the right images together as well as showing a preview 

image. If you go across the image with the mouse, the image will 

automatically enlarge itself. 

 

The file type-filter is practical here, since one often has jpg rows and 

RAW images together in one folder. But if you type in RAW in the 
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file type, only the RAW rows will be shown. You won´t have any 

doubles any more. 

At 100% the search for images is finished. 

From this point on you will be able to upload the desired bracketing 

series. Click on the desired row with a right mouse click and chose 

in the context menu “open as project”. 

 

 

 

HDR projects 7 uploads the images of the desired row and just like 

the simple Drag &Drop of the images on the desktop we start now 

with HDR preparation. 
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7. Menu Bar 

7.1 File 

File → Start  

When you are finished editing an 

image or would like to close your 

current image, clicking on Start (or 

Ctrl  + N) will close the image 

currently open.  

 

File → HDR from a Single 

Image  

To open an image, click HDR from 

a single image (or Ctrl + Shift + 

O). 

 

File → Import Exposure Bracketing   

In order to open an image, click on Import Exposure Bracketing (or Ctrl  + 

Shift + O) … to search for the exposure bracket you would like to edit.  

 

File → Exposure Bracketing Browser  

Select your bracket folder from within the “Source-Folder”. HDR projects 7 

immediately begins its calculation process and automatically gathers the 

best photos from your bracketed series. From here you can then upload your 

preferred exposure bracket.  

 

File → History Viewer  
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Clicking here will provide you with an overview of your separate projects and 

allow you to choose between them.  

 

 

File → Save Final Image  

If you are content with your editing results and would like to save your image, 

click on Save Final Image (or Ctrl  + S). 

 

File → Open Final Image in External Program  

If you would like to continue editing your current image in another program, 

you don’t even need to leave HDR projects 7. For this, simply click on 

Open Final Image in External Program. 

 

File → Export Exposure Bracketing  

Select Export Exposure Bracketing in order to save your edited exposure 

bracket and open it in an external program. 

 

File → Print Final Image  

Click here to print your final image. The image is automatically and correctly 

scaled to the print medium. 

 

File → Final Image Into Clipboard   

The final image is posted to the clipboard. You can then seamlessly insert it 

into other programs. 
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File → Projects  

If you’ve already begun a project in HDR projects 7 and would like to con-

tinue editing, open the file by clicking on Projects.  

 

 

File → Exit  

Click on Exit (or Ctrl  + F4) to close HDR projects 7 

 

7.2 Edit 

 
 

Edit → Edit Exposure Bracketing  

HDR projects 7 utilizes a complex process to filter out all accurately ex-

posed pixels and combine them into one image (please see 16. HDR Crea-

tion and RAW Image Editing).  

 

Edit → Edit Weightings  

The Weight Painter is a tool used for manually editing individual HDR imag-

es in a series in order to selectively alter specific regions of the photograph. 

(Please see 17. Edit Weighting with HDR Painter).  

 

Edit → Post-Processing  
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Once you have edited or 

removed noise from an image, 

you find yourself in Post-

Processing Mode.    

 

7.3 View 

 

View → Information Win-

dows  

This window displays all 

exposure bracket information 

regarding the preset settings.  

 

View → EXIF Information Window  

This window shows you (if available) all image file EXIF information such as 

location, camera type, exposure duration and capture time. 

 

View → Histogram  

The histogram provides you with a consolidated overview of the Light Dis-

tribution Information present within your photo. This makes it easy to 

recognize if your photo is over/ underexposed.  

 

View → Full Screen View On/Off  

If you ever feel distracted by the task bar, you can toggle between a normal 

and full screen view by clicking on Full Screen View On/Off.  

 

View → Interface-Style… (dark gray)  



HDR projects 7 – User manual 

 

27 

Clicking on Interface Style... will allow you to alter the colour scheme for 

HDR projects 7. The colour scheme you have currently selected will appear 

in brackets.  

 

 

View → Font  

Choose your individual font from all compatible and loaded fonts. HDR 

projects 7 now displays the entire interface in the font you have selected. 

 

View → Font Size…  

Change the font size levels between small, medium and large. 

 

View → Frame Colour: Gray Cart → automatic  

If you click on Frame Colour: Gray Cart, the program will set the your 

image’s average colour value as the frame colour.  

 

View → Restore Window defaults   

Returns the current window to its original size. 
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7.4 Extras 

 

 

Extras → HDR Preparation  

Here you can begin to prepare your images prior to HRD Creation (please 

see 8. HDR Preparation) 

 

Extras → Benchmark  

If you would like to test how quickly your PC can remove noise from your 

images, Benchmark is the function to choose. The programs will render five 

different images in real-time and provides you with an evaluation on a five-

star scale.  

Here the text size can be scaled in 4 sizes. 

 

 

Extras → Settings (Strg + P)  

Here you will find the various configuration options adaptable to your unique 

preferences offered in HDR projects 7. 
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Program: Program Location 

Here you can determine to which folder to save your projects, exposure 

bracketing/ photo series, final images and default settings. 

 

Program: Gamma conversion 

You can enter the development gamma value for all floating point file format 

HDR images (i.e. *.hdr and *.exr files) you load or save. 

 

Program: Language 

Here you can change the HDR projects 7 program language to either Ger-

man, English or French. 
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Program: Accelerate GPU 

Here you can choose to either activate or deactivate graphic card computing 

speed acceleration. 

 

Program: Tooltips 

Hovering your cursor long enough over specific tools or menu options will 

prompt the display of a short text offering an explanation of the function or 

tool. This is called Tooltip. Tooltips can also be deactivated here if preferred. 
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Program: Progress bar 

During processing of effects in HDR projects 7 professional, processing 

progress will be displayed with the help of a progress bar. Here you can 

decide when and whether to display the progress bar. 

 

Program: Projects 

When selecting the compression level, you are deciding how much storage 

space will be allocated for each one of your projects. At the same time, you 

are also deciding on how quickly the storage is performed. A lower level 

saves the projects faster, a higher level reduces the amount of storage 

space available on your hard disc. 

 

Program: Undo 

With the option “save undo steps in projects”, you can save all undo steps 

within the project file. The undo-steps will then be completely reproduced 

when the file is opened. This creates a significantly larger project file. Set the 

maximum number of undo steps (1, 5, 10, 20 or 50). If you do not wish to 

set a maximum, select “unlimited”.  

The minimum free disk space specifies the amount of free space on your 

hard drive that will not be taken up by saving undo steps. This ensures the 

proper functioning of your operating software. By default, this is set to 10% 

of your hard disk capacity but can be increased or decreased accordingly. 

 

Program: Preview Mode 

In preview mode you can choose between the modes “optimal” and “quick”. 

With the “optimal” mode activated, the preview size is adapted to the size of 

the original image. It guarantees maximum preview quality. If the “quick” 
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mode is activated, the preview size is reduced to half of that of the original 

image. This guarantees you the highest possible speed in preview mode. 

Moreover, you can set the size of your preview area in megapixels if you 

have not selected optimal or quick mode). Select a high value if you have a 

very fast computer. 

 

 

Export 

 

 

External Programs 



HDR projects 7 – User manual 

 

33 

Here you can choose in which format HDR projects 7 will export images to 

external programs. You can specify as well which programs should be used 

for external image editing. 

Navigate to the file in which the function is installed and select it. 

 

 

 

 

Calculation 
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Quality 

The Calculation quality is a measure of the size of the area of influence 

around a given pixel used when it is calculated in an algorithm.  

Superquadrics describe geometrical forms (in this case, areas) with specif-

ic curvatures.This geometrical form is transferred to the influential area of the 

algorithms. For each pixel only surrounding pixels that are within its super-

quadric are considered (shown as a white area). If you want to maximize 

calculation quality for your shots, push both slides as far right as they go. 

Remember that this will require far more processing power. 

Scanning density: Choose from four options how thoroughly the area of 

influence is scanned by the different algorithms. The option low provides fast 

results with lower quality, while the very high option provides the highest 

quality at the expense of processing time. 

 

HDR options 

There are two settings in HDR options: 

Smoothing mode 

There are four algorithms available for smoothing HDR weighting matrices. 

(a) linear smoothing is the simplest form of smoothing and is best for soft 

shots such as landscapes. 

(b) bilinear smoothing is a squared smoothing technique good for shots with 

some details.  

(c) trilenear smoothing is a cubed smoothing technique ideal for shots with 

some but not too many details.  

(d) quadrilinear smoothing is smoothing to the power of four and useful for 

shots with strong or complicated details. 
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Exposure curve  

Use the exposure curve to determine how your exposure series should be 

converted when optimised. The further to the right you slide the control, the 

lighter your exposures will become. The exposure curve resulting from the 

selected value will be shown to the right of the slider. 

 

Luminance conversion 

Luminance conversion allows you to determine which colour is valued higher 

when converted to brightness (luminance). You can select the three usual 

standard options in default settings. Alternatively, you can set colour 

weighting directly by using the slider. For this control, the sun of all three 

colour rations must add up to 100%.  

The two colour circles displayed help you to get an idea of how the value you 

entered affects the various colours. The left-hand circle shows the original 

colours while the right-hand circle shows the brightness as converted using 

your values. 

 

Save formats 

 

 

Jpg 

Jpg or Jpeg is the most common and popular format for most cameras and 

image editing programs. Here you can control the quality as well as optimally 
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compress the image. Compressed images with high quality look better but 

do require more storage space. 

Tif 

Here you can choose between different compression methods for your Tif 

files. 

Png 

Png is popular for its graphics and digital visualisation. Here you can choose 

between a number of compression methods. 

 

Automatic  

 

Automatic: Primary View 

Select whether the software should start in the post-processing or directly in 

the motion analysis after uploading image files. 
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Automatic: Motion Algorithms 

Here you can activate the resetting of the motion algorithms when opening a 

new sequence. 

 

Automatic: Post Processing 

Post-processing automatically sets the corn engine back to its original set-

tings with every newly started project. To use a fixed corn value in batch 

processing, set this in the program and then deactivate this option. 
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Automatic: Security Questions and Additional Information 

Here you can choose whether or not to display security questions or addi-

tional information. 

 

Automatic: Automatic Undo Points 

Creates an automatic Undo-Point before RAW development, sensor correc-

tion or selective drawing. This creates a definitive starting point after upload-

ing the image. 

 

Automatic: Image Preparation 

Displays the image preparation window when images are exported over a 

Plug-in. 

 

Automatic: Image Saving 

Activate the option “always save in highest resolution” and the processed 

image will automatically be saved in full resolution, even if the preview mode 

is active. Activate the option “show crop window when saving” and the crop 

window will automatically be displayed before image saving. 

 

Automatic: Point of Interest 

Is this option active, the full resolution image will automatically be displayed 

when the Point of Interest is started. 

 

Automatic: Batch Processing/ Image Data Browser 

Here you can activate the automatic loading with the last used directory 

when opening the image data browser. You also activate the automatic 

inclusion of subdirectories in the image data browser.  
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Extras → Reset  

This returns the current user interface to its original size. 

 

Extras → Create Restore Point (Shift + Z)  

If you would like to save your image in its current state and continue editing 

without initiating a file-save, simply select the option Create Restore Point 

or (Shift + Z). This allows you to return to the last saved state of your image 

at any time. 

 

Extras → Timeline (Ctrl + T)  

Click on the Timeline or (Ctrl + T) to display all saved Undo-Points. 

 

7.5 Add-ons 

 

Add-ons → Import Add-on  

With the help of Add-ons, you can now 

not only import Presets into HDR projects 7 but also integrate new Post 

Processing Modules that gives your Presets with an entirely new look. 

 

Add-ons → Remove Add-on  

This button lets you remove add-ons. 

 

Add-ons → Addon Information  
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Here you are provided with a display of all information regarding currently 

active Add-ons 
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7.6 Information 

 

Information → HDR projects – Homepage  

Click here to navigate to the HDR projects 7 homepage.  

 

Information → Show Shortcuts …  

Here you will find all keyboard shortcuts available in HDR projects 7. 

 

Information → Supported RAW Formats …  

A list of all cameras whose RAW Files are able to be opened in HDR pro-

jects 7. 

 

Information → Check For Updates …    

This checks online whether newer versions of the software are available for 

download. 

 

Information → About HDR projects (Shift + F1)  

Information about the current version, 3rd-Party Software and Credits from 

HDR projects 7. 
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8. HDR Preparation 

Here you can precisely configure the program’s settings.   

For the first steps, please use the standard settings. These default 

settings can be restored with the arrow at the bottom left. Nothing 

can be irretrievably adjusted.    
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a. Scaling: When bracketed series are uploaded, the images 

can be scaled from 25% up to 900% using any one of 6 dif-

ferent available Scaling Processes. 

 

b. Colour space conversion: 

Advanced users can choose 

a colour space here - for all 

other users, it is recom-

mended to not make any ad-

justments in order to avoid 

incorrect colour rendering 

later. HDR projects 7 offers 

several new colour spaces 

(D65). The standard illumi-

nant D65 is representative 

for a phase of natural daylight with the colour temperature 

of 6500° Kelvin. 

 

c. White balance: Corrects colour casts that occur with 

shots taken, for example, in shooting environments such 

as a warmly lit rooms. To start, leave this setting un-

changed.    

 
d. With this regulator one can adjust the colour temperature 

when you´re already uploading. It is advised that you leave 

the setting on “default” and to regulate the colour tempera-

ture later in post-processing. 
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e. Optimisations: The colour normalisation turns shadows 

black and lights white in the picture. During loading the Ad-

justment: RAW to camera display converts the RAW 

picture so that it’s almost the same as the camera preview 

as well as the file preview. The automatic brilliance op-

timisation for RAW files can be activated in image prepa-

ration under RAW options. Frequently it is with camera 

RAW formats that the image data will not use all tonal val-

ues that are available. The automatic brilliance optimisa-

tion compensates this with the uploaded RAW images by 

amplifying the tonal values so that a meaningful utilised 

histogram is created for every camera RAW image. 

 

In the area for bracketing series this option is only wise, if 

you create HDR images from a single RAW. 

If the Automatic rotation of images is activated, they are 

automatically rotated according to the Exif orientation. 

 
f. Noise suppression: these buttons allow you to select the 

precision of the noise removal, and the slider regulates the 

degree of the sharpness for the edges. Here dark images 

can undergo significant noise removal and have hot pixels 

(light spots caused by the camera’s sensor in dark situa-

tions) eliminated. 



HDR projects 7 – User manual 

 

46 

 

g. Exposure: can be chosen if an image in a bracketing se-

ries is improperly lit and/or blurry, and must therefore be 

supplemented by the program. With a dark bracketing se-

ries, it is recommended to use the “Optimise dark areas” 

function to remove any colour casts. Light areas and de-

tails can also be optimised for bright bracketing series. 

 

h. Alignment: Here you can control how individual images 

within the exposure series are superimposed upon one 

another. Fixes to the finest movements, unintended zoom-

ing, rotation of the camera and micro details can be con-

sidered here, however the default setting will most often 

lead you to the preferred result. Automatic cutting removes 

edges which appear when overlapping exposures. You 

can select “Nebula, night sky” or “landscape, architecture, 

people” or “soft motifs (strong bokeh)” to find the perfect 

alignment for your picture. 

 

i.  Automatic ghosting correction: HDR projects 7 uses a 

highly precise ghosting removal to filter out subjects and 

people moving within the bracketing series, i.e. which ap-

pear in different places on the individual images. Without a 

correction, people or vehicles would appear multiple times 

as a semi-transparent blur within your result image and 

create a complete mess, as they move and are at a differ-

ent location with each exposure.   
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Fusing the images without ghosting removal. People are always on 

the move in a busy train station! Without correction, ghosting always 

occurs with multiples exposures. 

 

A special procedure is the detailed forecast: It tries to predict 

movements within the exposure series and thus remove the ghost 

images more specifically. In addition, the intelligent coordination is 

adapted to living creatures, landscape, architecture and sport. Here 

the correction with the setting "creature" works perfectly. 
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9. Post-Processing: Presets 

 

Just like in the last version of HDR 

projects professional, after the upload-

ing of images we dive right into in 

post-processing. Here we control the 

tone mapping of the images, before 

editing the results with filters and ef-

fects.  

Left side of the post-processing 

screen:  

Before you begin testing the different 

Presets when continuing to edit your 

photos, remember you also have the 

HDR Style option at your disposal. 

Here you can choose between options 

such as “Balanced”, “Shade and 

Light”, Fine Details”, “Grunge”, and 

“Vibrancy”.  

The presets show the breakdown of 

the live preview in categories – „All”, 

„Natural”, „Landscape”, „Mono-

chrome”, „Colour fidelity”, „Grunge”, 

„Custom”, „Surreal“, „Architecture“, 

„Artistic”, „Glow” and „Micro-detail” – 

along with the quantity of presets in 
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the appropriate category.    
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To begin, we’ve chosen the “Natural balanced” preset. Clicking on 

the preview image applies the effect to the image in real time, which 

will then be displayed in the middle of the screen.  

Discover the wide variety of different looks by clicking on the 124 

different presets. You will be amazed by the intriguing styles in the 

artistic section!   

 
Image with „Micro-detail Crisp“ preset 
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Image with „Grunge Aura“ preset 

 

All 124 HDR projects 7 presets at a single glance. The bar “default 

settings” you can detach easily and adjust to the desired size. 

 

 Preview Gallery 

 

Would you like to see all the previews for the loaded image or se-

ries? Open up the category “all” and then click on the symbol. 

 

HDR projects 7 now constructs a browser gallery with all the pre-

sets. For a larger display click on the image. 

 

 
 

This very practical feature is reminiscent of good old contact sheets. 

You can create proofs to assess how the image with your favourite 

presets would look when printed. 
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 The variation browser 

 

The variation browser allows you to choose from different ver-

sions of a function and is primarily operated with the mouse: 

 Shifting the segment: hold down the left mouse but-

ton, before moving the mouse 

 Zooming in: scroll up 

 Zooming out: scroll down 

 Choosing the variant: double left click on the image 

 Setting a referent: left click on the image 

 Comparison with referent: hold down the right 

mouse button over the image 

 

The corresponding short cuts you can find under “information -> 

short cuts”. 

 

 
 

Click on the symbol and HDR projects 7 will show you the entire 

preview gallery of that chosen category. Zoom in now on the vari-

ant that you want to compare and set a reference image. 
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This reference image you will be able to put on any image through 

a left click of the mouse. You can fade in this reference image into 

the other image by holding down the right mouse button.  

The border surrounding the image in a green dashed line shows you 

the reference image so that you can make the comparison. In this 

way you can compare any two variants in the browser directly and 

visually. 

Example: As a reference image you choose the variant “landscape 

brilliant” and mark the image with a left mouse click. The green 

dashed line shows that you have chosen this image. 

 

 
 

Now you look for a different preview image, in this case Preset 

landscape bicolour 1 has been chosen. 
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Right click on the preset landscape bicolour 1 and the reference 

preset will fade in. As soon as you let go of the mouse button, you 

will see the Bicolour 1 Preset again. This is how you simply and 

purposefully compare looks with another before choosing the ones 

you like the best.  

 

Selection of your desired variation: 

With a double click you chose the variant. The relevant program 

settings will be carried out automatically. 

 

Tip:  

Your current choice will, when you open the window, be automati-

cally set as your reference image. 

 

 Combine Presets    

 

To merge two looks together use the “Combine default presets" 

button directly under the categories. These new presets will be 
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saved under "Custom". It’s that easy to expand your numerous 

options and accumulate new ideas! 

 

 Name Favourites    

 

Have you found certain presets that you love and instantly want to 

have handy? Click on the top right star in the preset window and 

add the setting to your favourites. By clicking the button, previews 

all of your favourite presets will be displayed. 

 

 Custom Presets  

One thing is certain regardless of 

which settings have been changed: 

If you have applied additional filters 

or adjusted a filter’s settings, the 

selected preset has been modified 

with the following symbol appearing 

to the right of the preview image:    
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Clicking  will reset the preset back to its initial state. Careful: All 

of the modifications applied up to this point will be undone! 

Clicking  saves all of the changes in a new preset. 

A dialog box will open where you can enter a new name for your 

preset or confirm the suggested one. The system will name it 

“Copy”.    

 

The preset will be saved and moved to the “Custom" presets cate-

gory. The new preset has been additionally generated and the start-

ing preset is preserved. You can also never overwrite a default 

preset!  

Let’s switch now to the “Custom" preset category.   

Here we can find our first custom preset.   

There are a few new symbols to the right of the preview image: 

 Is this the favourite preset that you have made? Mark it to find it 

right away next time! 

 

 Have you changed this preset and don’t want to lose this new 

look? Then create a new one!   
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 Reset the most recently changed settings for the newest pre-

set. 

 

 You have readjusted once again? 

No problem. Save the changes with 

the disk symbol. 

 

  Change the preset’s name. 

 

  You can also delete your custom preset entirely.   

 

 Use this to enter a search filter. For example, enter the search 

filter „Colour play”, and subsequently type the term into the search 

filter bar directly under “Import". All presets with this search filter will 

be displayed. 

You can enter the names of places you’ve visited on holiday and all 

of the presets that you used for those specific holiday photos will 

then be easy to find and to apply to other pictures.  

The filter drop down menu to the right already contains „Colour 

play”. Simply select it from the entered search filters. 

 

Save Undo-Point  

With the Save Undo-Point Function you can save your edits to 

an image at different intervals and later view these in the Time-

line and pick up where you left off.  
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 Timeline  

In the Timeline you can view and directly access all saved Un-

do-Points. 

 

 Image Sequence View  

Image Sequence View lets you view all sequences of your im-

age or series at a glance.  

 

 

 Panoramic View  

Panoramic View enables you to take an even closer look at 

your image by displaying it as a panorama image. 
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 Comparison View 

 

Do you want a comparison to the HDR 

image without tone mapping? Simply 

right click on the middle of the image 

to see the before/after result.  

A quick check on the editing process 

is available at any time. For an 

extensive overview with selectable 

areas and luminance display, click on 

the symbol bar. 

 

 

 Histogram  

The Histogram shows the distri-

bution of tonal values within your 

image.   

 

 

 

 Real Time Processing 

 

When activated, all of the changes that you have made to the preset 

settings will be immediately applied to the image. If this option is 

deactivated, then you will only see the outcome of your adjustments 

when you click the button “calculate afresh”:  
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 High-Quality Display 

 

Activate this option to see the preview image in high-resolution. If 

the preview is set at 100%, there will be no difference. If you zoom 

in on a section of the photo however, there is a noticeable differ-

ence in quality.  

 

 

 Border Pixel Display 

 

The border pixel display helps to reveal areas that tend towards 

maximal light and dark values that is to white and black. Dark border 

pixels are depicted by blue/ purple and light pixels by orange/ yel-

low. 

 
Depiction of border pixels in purple and orange tones.   

If you would want to brighten this image, you have to be careful of 

the orange border pixels. Light surfaces on the car and the walls 
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should not become too white, in order to avoid losing detail. In tech-

nical terms, these patches are called “burned highlights”. The bor-

der pixel view helps to find these critical image areas 

 

 Symbol „original resolution setting“ 

 

With this pushbutton you will set the zoom factor on the original 

resolution. 

 

  „Increase the Zoom factor to screen size“  

With this symbol you will enlarge the zoom factor to the maximum 

possible screen size. 

 

 

 

 Import/Export from Presets  

 

Presets from earlier versions can be easily imported. Do you wish to 

exchange all of your presets with a friend or just secure all of your 

treasures? Use the practical export function. 

 

 Filter presets 

Locating presets can be difficult when you have imported presets or 

created many additional looks. For example, enter “filter" into the 

search bar and only presets relating to “filter” will be shown, e.g. 
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“red filter”, “gradient filter” or “polarising filter”. This makes the 

search a lot easier. 
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10. Post-Processing: Finalisation 

Now that we have understood the 

most important part of post-

processing, let´s move on into the 

fine-tuning. This can be found on 

the right side of the screen under 

“Finalise”. These features are intended only to be used to continue 

to edit pictures after selecting a preset. 

 

 The magnifying glass  

On the right-hand side (at the very top) in Post-processing you will 

find the 1:1 magnifying glass. The magnifying glass shows you the 

area under the mouse in a 1:1 pixel view. 

 

When clicking on the magnifying glass the new compare window 

will appear. This compares your edited image and the original im-

age. It simultaneously gives you the opportunity to examine the 

comparison through the magnifier display. 
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To keep the magnifying glass on a specific point, press down on the 

“L“ key, while you move the mouse over the screen. 

          

Click into the image area of the magnifying glass, to change be-

tween the display modus “divided before/after comparison” and 

“direct before/after comparison”. To unlock the locked area, press 

the L button again. 

 Point of Interest    

Activated “Point of Interest” renders current edits only to a specially 

defined area of the image. The effects will be applied in their full 

form, however only visible in the specified spots, the rest of the 
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image will be left unaffected. This effect is intended for very large, 

high-resolution photos, e.g. panorama pictures.    

 

HDR/Ultra HDR   

This technology describes the art of fusion of bracketing series 

images. Ultra HDR processes up to 30 intermediate images be-

tween two photos with 64-bit precision. The result speaks for itself, 

and clearly shows a more detailed picture, especially in difficult 

situations, for example when shooting directly against the light.  

 

 

 

 

 

 

 

The strength of Ultra HDR can be seen in sensitive situations: the 

sunlight in the image on the right is significantly more detailed and 

less overexposed.   

 

This highly precise calculation system can be applied to specific 

types of motives: daylight, landscape, twilight, architecture, interior, 

night-time and mixed light. 

These settings can be accessed in post-processing at any time. 
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 Ultra-HDR mode „highlight boost“  

Activate the „highlight boost” to create a lot more realistic HDR-

photos in the 64-Bit-Ultra-HDR-Fusion. This mode is especially 

helpful when it comes to difficult lighting conditions. The „highlight 

booster” is activated by default and enables you to bring to life even 

the most subtle details within your photo. 

 

 Scenario   

Additionally, the HDR fusions can be influenced by different scenar-

ios. If you would like to adjust your result to a certain lighting, select 

one of the following seven scenarios: “Daylight”, “Landscape”, “Twi-

light”, “Architecture”, “Interior”, “Night-time" and “Mixed Light”. The 

scenario option has an overview of all of the possibilities that can be 

directly applied with just one click.   
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 HDR-Algorithms 

Here a mathematical equation is used to determine the weighting of 

each individual exposure in a series - pixel for pixel. Every algorithm 

has a different effect depending on the bracketing and subject. 

There is no right or wrong here, rather your originality is in com-

mand. Test your bracketing series with different algorithms and see 

how they affect your photos. Tip: The HDR algorithm “Entropy”, in 

most cases, will yield a finely tuned and detailed result in all tone 

values.   

 

 Intelligent Colour Space (SCA Method) 

 

This menu offers you options for optimal colour detail gradation of 

your tone mapping results. Selecting SCA method (Smart Col-

ourspace Adaptation) demonstrates differences in the details of 

more saturated colours.   

Tip: With “Supersampling” you will get exceptional details and satu-

rated colours and stark colour variations around contrast edges.  
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 Optimisation assistant 

 

The optimisation assistant is a very 

efficient tool for fast, fascinating 

results. 

When the preset is activated, 

denoising, tonal value, clarity, 

dynamic and sharpness settings 

can all be adjusted by sliding the 

control to the left or right. The result 

can be seen live. 

The optimisation assistant is 

intelligent; it remembers the values 

you entered, and applies the same 

settings to the next image in the 

same way, but tuning the result to 

the new motif.  

If you would like to edit without the assistant, you can simply turn it 

off. If you would like to turn off the values that have been “learned” 

so far, click on the   . 

Additionally, the assistant can be 

given optimising specifications for 

an entire image style: choose 

between „naturally cool”, „naturally 

warm”, „soft”, „fine”, „brilliant”, 

„intense”, „muted colours”, „Multi-

colour”, „High-Key”, „Low-Key” 
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und „Low-Key Multicolour”. 

 

 

 The opacity regulator of the optimisation assistant 

The opacity regulator in the optimisation assistant activates itself 

automatically as soon as one optimisation is activated. The opacity 

regulator works on every effect that 

optimises the image as well as the 

optimising presettings. 

 

Tip: 

Put the optimisation presetting in 

“High-Key” and chose an opacity 

regulator between 40-60%. 

 

Pro Tip:  

Remember that the preset specifications and Optimisation Assistant 

are added together. If you select the “Surreal powerful colours" 

preset and the “Intense” optimisation, you will get strong, saturated 

colours and dramatic contrast. Not to worry, you can quickly change 

back to the “Natural” optimisation and have the familiar look of the 

“Surreal powerful colours" again. On the other hand, you can com-

pile new creative ideas and jump between intense, unsaturated and 

high and low key looks lightning fast. 

 

 Granulation module 
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a) Natural grain 

In natural grain the different levels of photographic paper are simu-

lated, which creates a natural irregularity. 

These following parameters are therefore at your disposal: 

Form  

Choose here from six different variants. 

 

- ISO-Number 

The preset value conforms to the average “restless value” 

on a naturally grey surface. 

 

- Size 

The maximum size of the simulated grain. 

- Masking 
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Gives you the opportunity to calculate the granulation in all 

different types of daylight or alternatively in light, shade or 

shade and light. 

 

 

A Click on the button creates a new random distribution of 

grain and therefore a whole new look. 

 

 

b) Fractal grain 

 

Fractal grain simulates a large-scale irregularity, which is created 

through the storing and deterioration of photo material. For this, you 

have the following parameters at your disposal: 
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- ISO-Number 

The preset value conforms to the average “restless value” 

of a naturally grey surface. 

 

- Quality 

Determines the accuracy of the calculation (number of iter-

ations for the fractal algorithm) of the fractal granulation. 

In the granulation module there is no singular best setting, 

since the ideal grain size, form and quality is 100% de-

pendant on the motif. Here you can try out different things 

and find new creative paths.  

 

A Click on the button creates a new random distribution of 

grain and grants your image a whole new look. 

 

 Information and helpful tips on making local adjustments 

and using Selective Painting can be found in Chapter 12. 

Local Adjustments/Selective Painting.  
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11. Post-Processing Expert Mode 

 

The Post-Processing expert mode can 

be found on the right side of the screen. 

Here you can configure all postpro-

cessing, try new effects, adjust a select-

ed preset or construct a completely new 

preset to meet your desires. 

Overview of the Tools: 

a) Tone Mapping Algorithms 

b) Post-Processing Effects 

c) Selected Tone Mapping and Ef-

fects 

d) Settings for Selected Effects 

 

 a) Tonemappings (14) 

Tone mapping algorithms compromise 

the dynamic range of images with strong 

contrast down to a presentable range 

and serve to improve the quality of the 

image.  

HDR projects 7 offers 14 different algo-

rithm options that can be applied individ-

ually or combined.   
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Simply double click on the entry to add the tone mapping to your 

selected filter.    

All tone mapping works by compressing the local tone values and 

contains an integrated detail enhancer for macro and micro details. 

Tone Mapping Contrast: 

Contrast Tone Mapping creates well defined shadows and lights 

and well suited for landscape and architecture photographs. 

Tone Mapping Brilliance: 

Brilliance Tone Mapping creates a soft luminosity in the shot and is 

suitable for broad palettes in motifs. 

 

Tone Mapping Colour Fidelity:   

The newly developed colour fidelity processing works with maxi-

mum precision for colours in tone compression and is exceptionally 

suited to shots with intense colours.    

 

Tone Mapping Gradient:  

The tone mapping gradient algorithm has a substantial effect and is 

well suited to subjects with weak colours and high contrast.    

 

Tone Mapping Gradient Luminance:  

This process is a modified version of the gradient process, and 

especially enhances lighter areas. 

 

Tone Mapping Constant Gradient:  

This option yields best results for subjects with mainly middle col-

ours. 

 

Tone Mapping Averaged:  

Tone mapping middle values is a very stable process and suitable 

for almost every subject.      

 



HDR projects 7 – User manual 

 

75 

Tone Mapping Averaged Exponent:  

This effect is stable and works best for dark areas. It is especially 

well suited to tunnel and archway shots.    

 

Tone Mapping Averaged Gradient:  

This process was specially optimised for dark bracketing. Dark 

areas will be significantly lightened even with slight intensity (tone 

compression).   

Tone Mapping Quotient:  

This is a general tone mapping process that neutralises a colour 

saturated image, when compared to the effect of a gradient pro-

cess.    

 

Tone Mapping Sigmoid:  

The sigmoid function is specialised for scaling brightness of motives 

with drastic highlights. 

 

Tone Mapping Surreal:  

A very intense feature and therefore a good basis for extreme HDR 

images.    

 

Tonemapping Intense:  

Intense tone mapping works with a high bandwidth of tone com-

pression and therefore can be very effective for both dark and light 

bracketing series.    

 

Tonemapping Retina: 

The new tonemapping „Retina“ offers colour fidelity and a „total 

value“  which matches the human eye’s colour perception. It is par-

ticularly suitable for pictures with high contrast. 
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 b) Post Processing Effects (126)  

The list includes 126 different post-processing effects that can be 

freely applied and combined.   

The effects are divided into seven categories, each with a corre-

sponding background colour.   

 

Black: masking effects 

Yellow: border effects 

Green: geometric effects 

Turquoise: exposure effects 

Blue: colour effects 

Purple: diffusing effects 

Pink: artistic effects   

 

Tip: If you are looking for a certain effect and know its name or part 

thereof, you can save time by using the search bar. 

 

When you are applying new post-processing effects, check to see if 

the optimising assistant is active. If it is, please remember that ef-

fects will act differently, and sometimes more extreme. When con-

structing or enhancing a preset, it is best to turn it off. (Button above 

the tone mapping). 
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Overview of Post-Processing effects in HDR projects 7 
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 c) Select Effects 

Have you found an effect that you 

would like to try out? Simply double 

click on it in the post-processing effect 

list.   

The effect will now be shown in the 

block below called “Effects you have 

selected".   

The block of selected effects is the heart 

of the tone mapping and post-processing 

area. It includes all of the post-

processing effects and the settings for 

each individual effect.   

The filters in the example are automati-

cally applied one after the other to the 

HDR image and lead to the result tone 

mapping image.    

To temporarily deactivate an effect, 

simply click on the box beside the ef-

fect’s name and remove the checkmark.   

Double clicking on an effect removes it from the list.   

Effects can be sorted at will by dragging and dropping them up or 

down the list.   

One click on Result to Original will copy your image result into the 

pro-gram as its own original image. This allows for the creation of an 

export within the program itself.  
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Tip: The order of the effects within the list can have a substantial 

effect on the resulting image. It’s worth playing with!  

Activate the 360° panorama mode in the bottom left box to prepare 

your images for a perfect panorama stitching. The images will be 

optimised, so that no borders can be seen when the panorama is 

assembled.  

The context menu for the effects you have selected has numerous 

functions that allow you to activate, deactivate, move or duplicated 

effects.   

 

Smart-Mask-Filter 

HDR projects 7 calculates the selected effects from top to bottom. 

This means that the order of the effects within the list can have a 

significant influence on your result image. For example, if you acti-

vate the effect "Masking Lights", all subsequent effects will only 

affect the lights in your image. 

Below the selected effects display, you will also find the "Copy re-

sult image to original" function. This sets the current event image as 

the new original image. Use this function to save calculation time for 

many effects. 

 

 

 d) Settings for selected Ef-

fects 
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Settings for the selected effects can be found directly below the 

block for the effects you have selected. The parameters for the 

currently selected effects will always be shown here.   

The available settings and options change depending on the effect 

you click on. There are sliders, gradation and mask curves, colours 

and pipettes etc. Alternatively, a numerical value can be entered 

into the box above the slider. 

In the example, we see the parameters for “Colour Balance”, which 

consists of three controls for balance: cyan-red, magenta-green and 

yellow-blue. Sliding the controls instantly adjusts the image. The 

adjustments will be immediately portrayed in the result image. You 

will also see a colour flow within the controls, which will give you a 

direct indication of how the new value will affect the photo. 

 

 

 

 

 

 

Adjusting the cyan-red and yellow-blue 

values creates a signifi-cantly warmer 

feeling for the image.    

 

 

Example Mask Curves 

This curve regulates the intensity of the 

effect for particular bright areas of the 
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image.  When you pull a point downwards, pixels with this bright-

ness will be impacted less by this specific effect, and vice versa.    

Here as well you will find on the top right hand side a choice box 

with presettings. The setting “bright lights” has been chosen as an 

example. 

For the gradation curve in this example this means the lights in the 

picture will be brightened, and the dark roots exempted in order to 

create a striking contrast. This is how mask curves give 

you the opportunity to selectively influence images.   

During the editing, the preview behind the mask curve 

immediately shows the effect’s intensity from black (no 

effect) to white (full effect).    

Layer Processing Methods  

These features determine the way that an applied effect 

appears on a layer. Effects can thus be enhanced or 

reduced, and looks can even be completely changed, 

which opens up a plethora of opportunities to play with. 

To apply processing methods, click on the drop down 

menu beginning with “Normal”.   

In HDR projects 7 there are now 18 new layer pro-

cessing methods in HSV and HSL colour spaces. 

HSV stands for Hue, Saturation and Value. HSL stands 

for Hue (colour angle), Saturation (colour saturation) and Lightness 

(brightness). 

So that you don’t have to try out every single effect, we have a layer 

mode browser:   
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With just one click, you have an overview of all of the processing 

methods and can comfortably choose which method fits the effect 

best. Give it a try! The effects that you can generate with layer pro-

cessing methods are astounding!   

 

 Selective Editing    

For every single one of the 81 post-processing effects it is possible 

to apply the selected effect to only a certain area.   

Furthermore, specified areas of an image can be influenced at dif-

ferent intensities by different effects.  

The selective editing can be controlled in the parameter area of 

each effect and you can open the accompanying window with the 

button at the far left.   

At the bottom of this window there are three blocks with six, three 

and two buttons. 

6er-Block: add, remove, duplicate, flip and delete the selected 

areas 
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3er-Block: various display modes for the resulting intensity of the 

effect 

2er-Block: choice of selected surfaces, very practical if the speci-

fied areas are very small or overlapping 

You can add up to 32 amplifying (positive) or reducing (negative) 

areas for the current effect. The size and position can be deter-

mined directly in the image, optionally in the corners or on the sides 

of the area.    

The roundness of the rectangle as well as the sharpness and se-

verity of the selected area can be adjusted with the three controls at 

the top of the window.   
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The example clearly shows that the „Colour Luminosity“ effect has 

only been applied to the selected section. Since the edge definition is 

only set to 95%, this area is almost rectangular. 

The result will always be instantly displayed upon releasing the 

mouse button. 

 

 Selective Editing – gradient module  

You can choose from every post-processing effect in the area of 

selective editing a course (gradient) of 56 premade models with a 

single click. 

To activate the desired post-processing effect from your chosen 

effects, click in the underlying parameter area on the gradient- slid-

er. 
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A window will open with different types of gradients. From there 

choose with a left click your desired type of gradient. 

 

Tip: 

When you choose a gradient model the selected areas (that are 

possibly already part of the current chosen effect present) will be 

copied into the clipboard. The selected areas can be brought back 

via the insertion of the slider. 

 

 Overview of Certain Keyboard Shortcuts 

Cursor Buttons: movement of the currently active, selected area 

Ctrl/Alt + Cursor: fast movement of the current active, selected 

area  

1,2,3: switch the display mode  

Delete: deletes the current, active, selected area  
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Esc: closes the window  

Upon closing the window, the chosen effect will only be applied to 

the selected area and displayed in the middle of the screen.   

You can transfer other effects to the selected area with the “Copy” 

and “Paste” buttons , without having to retrace the selection again. 

 

 

This button deletes all selected areas of the active filter, of 

course with a confirmation prompt first. 
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12. Local Adjustments and Selective Drawing 

 

 The selective highlight tool from HDR projects 7 deserves very 

special attention. Firstly, this tool selectively edits chosen areas 

without complicated masks done by hand, like other photo editing 

programs. HDR projects 7 includes a completely newly developed 

intelligent border recognition algorithm that independently identifies 

borders, lines, differentiations and light differences in drawing 

mode. The boundaries of the area that the mouse skimmed over are 

saved as a mask. These easily and 

precisely set masks serve as the 

basis for eleven important image 

enhancements: „Correct red eye”, 

„Beauty”, „Shading”, „Illuminating”, 

„Intensifying colour”, „Reduce col-

our“, „Strengthen details”, „Reduce 

details” and „Sharpen”, etc… 

These masks can even be saved as 

its own image file and used in other photo editing programs.    

How it all works is probably easiest to explain with an example. 

Open the selective drawing window (post-processing, finalise - 

bottom right). Our example is a single image file of a typical twilight 

on the beach. The picture’s colour details are already well edited. 

Now we want to slightly brighten the rocks without taking away the 

evening mood; the sky, water and beach should not be brightened.    
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 Quickly finalize your image with Selective Drawing 

1. Select editing objective  

For this case, select “Illuminating”. Make sure that the se-

lected mask function is activated and the green checkmark 

is showing.    

 

2. Activate Drawing Mode    

3. Activate Filling Mode    

4. Run the mouse over the contours without clicking. You can 

decide and correct the brush size afterwards. 
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5. Now look at the mask display. The object where the bor-

ders were automatically recognised is now depicted. Click 

and hold, and then trace your mouse along the edges of 

your chosen object until it is completely selected. In the 

blink of an eye we will see the effect as well as the overly-

ing mask.   

 

 

6. Once fully selected, blend the mask out by moving the 

mask intensity control to the left.   

   

7. You will now see only the effect that is brighter rocks - our 

objective was “Illuminating”. Now you can adjust the inten-

sity of the effect by sliding the control towards the + or -, 



HDR projects 7 – User manual 

 

90 

according to your preferred strength. Done: the rocks are 

brighter while the sky, beach and water remain untouched 

by the editing.   

8. Click on “Close”. You will be returned to post-processing 

and the selective change will be applied. 

 

The rocks on the left are significantly brighter after the selective 

correction. The sky and sea still have the same tone values as before.    

 

9. Use your quickly made mask for a further effect. Go back 

to the selective drawing. Our selective mask has remained.  

10. Click on  and copy the mask to the clipboard. Switch 

the mask to “Sharpen” and use the  to paste the mask 

back again. Now you have sharpened just the rocks, and 

the other parts of the image were not influenced. 
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11. Every selectively applied effect can be activated and deac-

tivated with the green checkmarks.    

12. Borders have different intensities in every image. Presets 

normally do just fine, but sometimes it is necessary to ad-

just the contour and sharpness settings in order to reach 

perfect fine-tuned results. 

 

 

13. Have you drawn outside of the lines, despite the border 

recognition? You can easily remove it with the eraser .     

If you only want to remove a small section, use the eraser 

with limitation. When set to 50%, you can only remove 

50% of the mask, regardless of how much you erase. The 

limited drawing mode works in the same way, and only 

draws at a certain opacity. 

14. If you want to mask the entire image except for a small ob-

ject, it is a good idea to mask only the small object and 

then reverse the mask by clicking on the  

 

Pro Tip:  You have two filling modes to choose from when you want 

to fill a mask. When do you use which mask? We used the normal 

fill mode  as in our example for a large surface, which is also 

preferred for water and sky areas 
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Ray filling mode   is very precise and favoured for smaller ob-

jects, geometric forms or subjects with straight lines, like in our 

example here. 

 

With ray filling mode you can mask just the walls of the skyscraper 

while the window surfaces are not selected.    

 

Pro Tip 2:  If you would like to incorporate sections of your original 

image into the edited image, you should work with bracketed series. 

Recommended here is the use of at least three different exposures.  

 

This dark field will serve as an example: 
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After uploading the bracketed series, select a preset you would like 

to use and make further improvements to it using any of the various 

editing options.  

The edited version now appears much brighter:  
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Because the edited field appears unrealistic, the darker field from 

the original image is taken. For that you change to the selective 

painting and choose “show original image” as mask function.  

 

 

Adjust the size and opacity of the brush and select the whole field. 

Now you can move the mask intensity control to the left to blend out 

the mask. The field is optimally exposed if you adjust a medium 

intensity for the effect. 

 

As a result the field is darker, but there is still a HDR effect recog-

nisable: 
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Functions and Possibilities in Selective Drawing 

- Optional mask colours 

Designate a colour for the presentation of the mask as well as the 

brush one of the ready-made colours.  

 

The display will be immediately adjusted to your desired colour. 

 

- Selective Drawing – Creating Masks 

 

Masks can also be created from a colour or brightness. 

 

With the button (1) you activate the “Create Mask” modus. You will 

find yourself in the standard mode “Create Mask out of Colour”(2). If 

you want to create the mask from of a brightness, chose the (3) 

button. 

The tolerance controller decides, how sharp (smaller value) or 

soft (higher value) the created mask will be. 

While you are in the “create mask” mode your mouse pointer will 

turn into a pipette. The colour or brightness in which your mouse 

pointer is set, will determine the type of mask being created. 
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In the above example we can see how a red mask has been created 

for the sky. 

Tip: If you want to combine several colours in one mask, simply 

click on the desired colours after each other with the pipette on the 

screen. The current colour will with every click be added to the 

current mask. 

 

- Selective Drawing – Smoothing Brush 

The smoothing brush (1) gives you the opportunity to draw selective 

areas of the mask softly.  

 

To draw an area even softer, just go over the same area with the 

smoothing brush several times. 
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- Global Mask Functions 

In the area of global mask functions you will find several special 

modes that you can use directly.  
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1.  Reducing the entire mask outline 

becomes    

 

2.  Increasing the entire mask outline 

 becomes   

 

3.  Soft-focus effect on the entire mask 

becomes    

 

With global functions there are two buttons – the left button fulfils the 

function with a lower effect while the one on the right with a bigger 

effect. 
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- Reset the Function of a Mask 

Every mask can be reset to its original state without effecting any 

other masks. Simply click on the waste paper button (1). 

 

After clicking on the button a security query will appear, so that no 

important work is lost by accident.  

 

 

- Colour filter in selective drawing 

In addition to effect masks you 

will find the field of colour filter 

masks. Click on the dropdown 

menu to choose one of the follow-

ing filters: red, orange, yellow, 

yellow-green, green, cyan, blue 

and violet. 
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13. Composing Mode 

 

In the Composing mode of selective 

drawing you have the ability to build up 

to 4 layers of images into your current 

motif. 

To switch into the composing modus, 

click on the “composing” button (1). 

From the list of choices (2) you can 

choose with which composing level 

you want to work with. 

With the button (3) you activate the 

currently chosen mask. Now you can 

through a click on the frame of the 

image (4) upload any image you wish 

to create the next level. 

You can use RAW images, Jpg, Tiff as 

well as several other image formats. 

Underneath the display screen you will 

find the parameter area that begins 

with two buttons with the following 

functions: 

 

(5) Multiple application 

Reduce the size of the image on a 
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different level than the one that you´re currently working on. With 

this option you will be able to stretch the reduced image outwards 

(up, down, left, right). 

 

(6) Determine the width-to-height ratio 

This function allows you to determine the width-to-height ratio of the 

uploaded levels, since the width-to-height ratio in an uploaded im-

age level can differentiate from the current image you´re working on. 

This preserves the proportion of the levels. 

 (7) Horizontal Reflection 

This function allows the image layer to be mirrored horizontally. This 

enables more precise adjustment to the current image without hav-

ing to make changes to the image layer.  

(8) Vertical Reflection 

This function allows the image layer to be mirrored vertically. This 

enables more precise adjustment to the current image without hav-

ing to make changes to the image layer.  

 (9) The Control-parameter 

Width-to-height ratio: If the width-to-height ratio isn´t fixed with the 

button (6), you will be able to change the width-to-height ratio how-

ever you desire. 

Zoom: Choose the size of that image level by zooming in or out 

Shifting horizontally: Move the image level to the left or right 

Shifting vertically: Move the image of that level up or down. 

Exposure to light: Regularly the light from your current image does 

not match with the exposure of your other image levels. Here you 
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can adapt the exposure and darken or brighten the images however 

you want, so that they match. 

 

A night image with a not very fascinating night sky... 

 

....you can change within a minute with the help of composing 

into an eyecatcher. 
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14. Texture Masks 

The texture module of HDR projects 7 in Selective Drawing allows 

you to add textures and materials to your image. By clicking on the 

corresponding symbol, the texture 

selection appears. 

Here you can find the 64 different 

textures you have at your disposal. These can be applied to your 

image on up to 16 different layers.  

Clicking on the Zoom Field will show all 64 different textures at a 

glance and allow to choose between them.  

 

 

 

For this, simply click on your preferred texture and use the Selective 

Paintbrush to apply it to your image.   



HDR projects 7 – User manual 

 

105 

 

In the Menu at the right of your screen you are given the option to 

further adjust your chosen textures according to various parame-

ters. The editing possibilities available here include options such as 

Exposure, Contrast, Zoom, Highlight, Image Structure, Distortion 

and Colour Variation.  

In addition to these, Selective Drawing also includes a module for 

creating your own textures using your own individual design. Here 

you can choose between four different automatic edge alignment 

procedures.  

 

To open the module, move the mouse over a texture until the plus 

symbol appears: . This opens the additional functions. Click on 
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, to load an image file and convert it to a square texture. To save 

a texture as an image file, click  . After you have decided on an 

edge angle, either a selection for adjusting the structure size or for 

adjusting the brightness opens. 

 

 

Save mask: Click on  to save the current mask as an image file. 

Load image file as mask: Click on  to load an image file into 

the current mask. The resolution of the loaded image file is automat-

ically adjusted to the resolution of the current mask. 

 

It is also possible to import or export textures from the texture data-

base. Click on the corresponding button and choose between im-

port and export of the textures.  
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Note: By resetting the database, you can return to the supplied 

textures at any time. 

Click on  to reset the texture database to the installation state. 

If you click on  a complete texture database is created from 

the textures you have loaded. 
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Note: The textures generated with the program are created by 

fading the surrounding textures around the respective texture.  

 

 

Use the sliders on the left to adjust the textures. 
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15. Removal of Scratch and Sensor Errors 

 

Micro-contrast enhancement used in HDR photography unfortu-

nately shows every unwanted sensor imperfection that every pho-

tographer, despite internal camera sensor cleaning, knows and 

dreads. Don’t stress - just eliminate them! With the easy to apply 

correction function from HDR projects 7, it can even be fun.   

Pro Tip: This intelligent correction doesn’t only remove sensor 

spots, but other disturbing things too - a deserted beach has never 

been so easy to produce.   

Simply mark defects in your motif, the program will automatically 

substitute these areas with other appropriate parts of the image.   

 

 

 

 

 

 

 

 

The sensor spots are circled in red
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Here’s how to go about correcting: 

Select the brush tool under (6) and click on the point of the image 

that you would like to correct. A circle will appear beside it that will 

serve as a source.  

Move this circle to a place on the 

image that can act as a source for 

the first marking. The selected area 

will then be improved based on the 

source.  

 

Prior to this, you can reveal sensor 

spots, which will appear as a bright 

patch in the image, with (1).  

 

(2) Allows you to expose or hide the 

fixed areas. The corrections are still 

active, even if they have been blended in.  Hiding is solely to enable 

a before and after comparison.  

You can select multiple areas to correct by simply clicking on the 

brush symbol (6) and adding another point.   

 

The button marked (3) can blend the targeted corrections in and 

out, which also controls clarity.  

 

NEW: Under the quality (10) tab, a dropdown menu including five 

new quality modes allowing you to automatically search for corre-

sponding areas will open. With the different quality levels you can 

scale how the automatic search proceeds. 
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Note: This search quality is used for all of the following search area 

settings. 

(5) Deletes the added corrections.   

 

The section marked (7) controls the size of the area that is to be 

corrected.   

 

You also have the option to automatically search for the best source 

area for the improvement. Click on the (8) button.   

 

Button (4) calculates the appropriate correction spots for all of the 

points automatically set using (8).   

All currently selected corrections can be deleted with the (9) button.   
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The sensor spot corrector marks all of the patches and determines a 

source within the image that can be used as a substitute. 

 

 

Successful sensor spot correction. 



HDR projects 7 – User manual 

 

114 

16. HDR Generation and Bracketing Editing 

What happens in actual HDR image generation in HDR projects 7 

before post-processing has made the image printable and suitable 

for display on monitors?   

In a bracketing series, every individual image area contains a vari-

ous number of pixels that are either under or over exposed. Let’s 

assume that every section of the photo is correctly exposed in at 

least one of the images in the series.   

HDR projects 7 uses a complex process to correctly filter out all of 

the accurately lit pixels and assemble them into one complete im-

age. The process is determined by mathematical commands - the 

algorithms. Various algorithms influence different HDR results, 

which depend on the final brightness of the series of images.   

The software professionally takes over this process for us. We 

simply have to attend to the result and decide which outcome is 

most visually pleasing to us and which HDR image we would like to 

edit further.    

 

 HDR Weighting  

From post-processing in HDR projects 7, transfer to HDR genera-

tion with this button. We see the work area on the left-hand side for 

HDR weighting, and HDR algorithms on the right. Your HDR picture 

will always be displayed in the middle of the screen while editing. At 

the moment the image doesn’t look all that spectacular, but remem-

ber that the monitor cannot yet properly show what was actually 

calculated.    
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 NEW: Presets for the HDR weighting distribution 

Above the actual bracket series you can find presets controlling the 

automatic settings for global weightings. 

The denoising technique „midtones dominate” is set in default. 

 

 

Even distribution: All pictures have the same influence on the 

HDR picture and thus create a unique result for every bracketed 

series. However, some aspects of image noise such as dark expo-

sure may remain. 

Master dominant: The master image (centrally exposed image) 

dominates the fusion of the HDR image. 

Therefore, the processed image of the HDR fusion is close to the 

central exposure but contains additional details from dark and light 

images. 
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Lights dominate: The HDR fusion concentrates on the light imag-

es, and primarily attempts to determine the details there.  

Exposure brackets that are generally very dark are lightened with 

this weighting algorithm and are thus optimised for further pro-

cessing. 

Shadow dominant: Here, most of the information is taken from the 

dark images of the exposure bracketing.  

Processing leaves your image with the maximum amount of details 

but also possesses the tendency of intensifying image noise in 

darker images and is thus suitable for exposure brackets with low 

ISO value. 

Midtones dominate: With this form of weighting, the main infor-

mation from the images within the exposure bracket which are opti-

mally exposed in the midtones is used. 

This method reduces noise and is extremely suitable for dark pic-

tures with high ISO values. 

 

To further fine-tune the weight distribution, you will find the following 

functions under the presets for weight distribution: 

 

a. The checkbox at the top left allows you 

to exclude or activate an image from the 

series for HDR processing. If you re-

move a bright picture from the series, 

the HDR image will be darker in the midtones in certain ar-

eas and vice versa.    
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b. Directly below is the minia-

ture view of the single 

bracketing exposure. Left 

click to display the image at 

full size. Another left click 

on the mini-picture will re-

turn the HDR final image.  

c. To the right of the colour view you can see the HDR 

weighting matrix of the exposure series image. Bright 

pixels mean that this area is very strongly reflected in the 

HDR result image. Dark pixels mean that this area is 

weak in the HDR result image. 

d.  The minus button  under the weighting colour re-

moves an image from the loaded bracketing series. It is 

only possible to delete 

exposures that are 

above or below the 

master image. The 

master image itself 

cannot be removed 

and has no minus 

symbol.  

e.  The button to the left under the bracketing preview 

image selects a new master image. You will clearly see a 

significant difference in the brightness distribution of the 

HDR fusion. 
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 Synthetic Bracketing 

With help from this exceptional technique, gaps in bracketing series 

can be filled.   

Let’s suppose, and this is no individual case, that the longest expo-

sure of a series came out somewhat blurry. Click to remove the 

image from the series and let the system generate a synthetic bright 

image for you. All of the shots in the series are already sharp.   

This technique can also be used for manufacturing an HDR image 

out of a single picture. Two synthetic exposures will be generated 

for an uploaded single image, one with reduced exposure time and 

one with increased exposure 

time. An additional image will be 

synthe- sised when only two brack-

eting images are uploaded so that there are always at least three 

photos available in a bracketing series.  

Click on                                                                       and add another 

synthetic image to the series. The original image will always be 

used as the master image. New images will be labelled as “Synthet-

ic”.    
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 Global weight & Exposure value (EV) 

For every exposure in bracketing series, synthetic or real, there are 

two controls that are very influential on the HDR process:  

• Global weight 

• Exposure value (EV) 

     

        

The example shows the master image directly 

after being loaded. The weighting and exposure 

controls are in the middle. The window to the 

right of the preview shows how the image is 

represented in the HDR fusion. Sliding the glob-

al weight to the right, raising it, increases the 

proportion of this image in the final HDR fusion. 

This can also be recognised through a brighter 

weighting matrix. Here “Bright” does not mean 

that the image will become brighter, rather that 

the shot will compose a greater portion of the 

HDR fusion. The result can become brighter or 
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darker.   

The picture will become brighter once you adjust the exposure con-

trol underneath towards “Bright”. This adjustment can be applied to 

each image in the bracketing series and therefore have a substan-

tial impact on the HDR fusion.   

Simply try it out! If need be you can set the controls any time back to 

its original setting. 

 

 Right side "Edit Exposure Bracketing” 

 

a. HDR Fusion profiles 

HDR fusion profiles are the optimal way to save the HDR fusion 

settings from an exposure series for later work and reuse them.  

 

 The following functions are available for the HDR fusion 

profiles: 

 Selection of a profile in the selection list by clicking on it 

 Saving the current settings as a profile 

 Delete the current profile 

 Import / export of profiles 

 

Which settings are stored in an HDR fusion profile? 
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Basically, all data of the HDR fusion settings are stored in a profile: 

 The settings of all HDR algorithms 

 The automatic motif brilliance 

 Ghost Correction Settings 

 Contrast range optimization 

 

b. HDR Fusions Method 

HDR/Ultra HDR    

Ultra-HDR technology for the fusion of exposure series images:  

Ultra-HDR calculates up to 30 intermediate images between two 

photos, with an accuracy of 64 bit.  

The result is impressive and shows much more detailed images and 

better results at critical points (e.g. when photographing in direct 

backlighting), see Chapter 10 "Post-Processing: Finalisation". 

You can also access these settings at any time in post-processing.   

Ultra HDR Mode „Highlight Boost“  

The standard activated ultra-HDR mode „Highlight Boost” creates 

more realistic HDR-pictures. Especially tricky lighting conditions can 

be mastered with the new mode. It helps to bring all the details in 

your images to life – details such as hair structure, for example. 
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Scenario   

In addition, the HDR mergers can be influenced with scenarios. If 

you want your results to be adapted to specific lighting situations, 

select from seven scenarios: "daylight", "landscape", "twilight", 

"architecture", "interior", "night shot" and "mixed light". The scenario 

browser gives us an overview of all the options that we can set 

directly by clicking on the picture.  

HDR Algorithms 

The HDR algorithms are located together with the parameter con-

trols on the right side of the user interface. 

An HDR algorithm is a mathematical rule that defines the weights 

(see weighting view in the exposure bracket) of each exposure 

bracket image per pixel. Each algorithm has a different effect on the 

HDR result image and has strengths and weaknesses depending 

on the subject. 

 

Overview of HDR Algorithms  

HDR projects 7 offers 13 different HDR algorithms to choose from. 

Click on the algorithm browser for a quick overview. Here you can 

choose your preferred settings.    

Average: The average is the easiest form of HDR generation and 

uses the bracketing midtones.    

Entropy: In information theory, entropy is a measure of the density 

of information. When applied to an HDR fusion, the appropriate 
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algorithm measures the density of information of each of the brack-

eting images pixel for pixel and converts this weight into the HDR 

generation. The result is a very stable process that is set as a 

standard algorithm for HDR projects 7.    

Luminance Distance: Luminance distance applies the average 

brightness distance in the image as the weighting for the HDR fu-

sion. This algorithm is also a universally applicable process that can 

be used for almost every bracketing series.    

Colourmix: The colour mix process applies the colour proportions 

of the pixels as a weighting measurement. It is particularly suitable 

for bracketing series with limited brightness differences in certain 

areas, for example fog, smoke or cloud shots.    

Luminance Entropy: The luminance entropy is a combination of 

the Luminance Distance and Entropy processes.    

Luminance RGB: The RGB process combines the Luminance 

Distance and Colourmix processes into a new procedure which is 

best suited to landscape shots 

Linear Luminance: The linear luminance applies the luminance as 

the weighting for the pixels.    

Logarithmical Luminance: This algorithm works with logarithmic 

brightness (luminance). This corresponds to the human eye’s per-

ception of brightness, which makes this algorithm appropriate for 

most bracketing series.    

Quadratic Luminance: This algorithm works with the fourth power 

of brightness and is thus well suited to editing bright bracketing 

series.    
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Chroma: This algorithm calculates the weighting from the colours of 

the individual images and is best suited to bracketing series with 

high colour contrast.    

Absolute Distance: A very powerful HDR fusion technique, which 

combines two essential features. When HDR Smoothing is deac-

tivated, all HDR images are free of halos and brightness outlines are 

avoided.    

Luminance Sharpness: For this algorithm, the luminance sharp-

ness (brightness) is determined for each pixel and converted into a 

weighting. This process yields the best detail for HDR fusions.    

Colour Sharpness: The colour sharpness process, like the lumi-

nance sharpness feature, determines the sharpness – the level of 

detail, that is – for every pixel. This technique uses each colour 

channel, and is thus best suited for bracketing series with intense 

colours. 

Repro neutral: This HDR-process is specially optimised for brack-

eting series of scanned photo data with a normal light situations. 

 

Repro intensive: The Repro intensive HDR-process is built for 

scanned images with low quality such as images from old Dia-

scans. The fusion of images is here clearly carried out even more 

intensive. 

 

Which algorithm should I choose? If you are not sure which 

algorithm would be best suited to your subject, use the “Absolute 

Distance”. This one is always a good choice.  

Otherwise, you can always access and adjust the HDR algorithms 

and post-processing/tone mapping at any time.     
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c. HDR Smoothing for Select-

ed Algorithms 

Just below the selection list for 

HDR algorithms is a block with 

controls for fine-tuning colour 

sharpness: “Chroma HDR smooth-

ing" from sharp to very soft.  

 

Further parameters for the adjustments of HDR algorithms: 

Denoising: Denoising appears 

directly on the HDR image and the 

noise removal intensity is also 

presented as a percent. A value of 

0% means that no noise pixel will 

be removed, and a higher value 

removes more noise from the HDR 

image, which would be favoured for 

sharpening an image.    

HDR Smoothing: HDR smoothing 

directly influences the weighting 

matrixes that were created by the 

HDR algorithms. The smoothing 

intensity is displayed as a percent-

age, indicating how dependent the 

result is on the image resolution. A 

value of 50% means that weighting 
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matrixes will be smoothed by 50% of the image resolution. The 

smoothing works with the Gauß´schen scrim diffuser.  

Night/Daytime: The day and night controls match the HDR algo-

rithms to day or night shots. Move the control to the left for night, 

when your bracketing series is suited to a night image, and to the 

right for day, when your bracketing series is suited to a photo taken 

during the day. You can also just as easily switch the setting to 

quickly change the picture’s mood.   

For some HDR algorithms there is an additional feature available, in 

this example the “Luminance Distance”. 

 

Halo Adjustment: The halo ad-

justment deals with a typical HDR 

generation problem: the formation 

of halo effect (HDR shadows). The 

image on the left has a minor de-

fect, there are halos where the roof 

meets the sky. 

 

In the right-hand image, the halos were reduced by 85%, so that the 

halo effect around the roof has disappeared. 
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d. Motiv-Brillanz  

 

Subject-brilliance: Activate the automatic intelligent optimisation 

by clicking on the box. 

 

Ghosting correction 

(Interactive, automatic optimisation of ghosting correction) 

 

In the area of ghosting correction, the automatic optimisation is 

started by clicking on the “automatic optimisation” button.   

 

 

Directly on screen you will be to see the optimisation process. Here 

different parameters for the detail prognosis as well as for the inten-

The halo control is available for certain HDR algorithms, here the “Lumi-

nance Entropy” algorithm was used. 
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sity are tested by the program until the best combination is found. 

This combination will then be inserted into the program for you. 

 

This calculation can take several seconds, depending on the size of 

your bracketing series. 

In the result you will get an HDR-image without ghosting and which 

through automatic optimisation now includes the maximum possible 

amount of details. 

 

Tip:  

When you adjust the focus of the ghosting correction, you will be 

able to start the automatic optimisation anew and to receive a new 

result that is optimal for the new focus. 

 

 

 

e. Contrast range 

(HDR-contrast range and automatic optimisation) 
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The contrast range of an HDR image is made up of the division 

between the brightest area of a photo – a photo shot directly into the 

sun, for example – and the darkest area, so in the shaded areas of 

the image. 

 

 

A calculation example: 

The brightest area of an image has a value of 5 (the value 1 would 

mean a white pixel in the image) 

and the darkest area in the HDR 

image has a value of 0.01. 

 

If one divides now 5 by 0.01 then 

the resulting contrast rage of 

5/0.01 = 500. This means that the 

proportion between the brightest 

to the darkest area of the image is 

500 to 1.  

From this contrast range you can take inspiration from the area 

“contrast range”. 
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The compression value shows how strong the compression of the 

HDR image brightness is in comparison to a non-manipulated HDR 

image. Here it is 0%, since we haven’t done any changes yet. 

The compression value you can adjust as you wish to. A low value 

creates a higher contrast range in the HDR image (the HDR is being 

“stretched” in its brightness). A higher value creates a smaller con-

trast range (the HDR is being “compressed” in its brightness). 

Underneath the controller you will find three buttons, which control 

the automatic optimisation of the contrast range: 

 High-contrast: Creates a high-contrast HDR image. This 

is an image with very deep shadows and very bright lights. 

 Optimal: Creates a well-balanced HDR image. 
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 Compressed: Creates an HDR image with a small con-

trast range. This can be helpful with contrast rich bracket-

ing series, since it helps to bring out further details in tone 

mapping. 

As soon as you confirm the automatic mode, you will be able to 

follow in real-time how the best values for your current HDR image 

are determined. 

Tip:  

This value is for every HDR algorithm different. Therefore it may be 

a good idea to click on the desired automatic function after chang-

ing an HDR algorithm. 

Under the automatic optimisation buttons you will find a curve dis-

play. This shows how much the brightness values of the HDR image 

have been adapted in the contrast range optimisation of the pro-

gram. 

 

Curve display of the distribution of the brightness value: 

     

High-contrast     Optimal          Compressed 
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In the above example, we see how the same HDR image with the 

optimisation “high-contrast” (above image) and the other with the 

optimisation “compressed” (bottom image) are handled. 
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17. Edit Weighting with the HDR Painter    

 

HDR painter is a powerful tool to manually adjust certain areas by 

editing individual images of a bracketing series 

 

  

Exposure Bracketing View (left):  The individual images of a 

series are sorted into red, green and blue. When the bracketing has 

more than 3 exposures, the master image will be set as green and 

the next active neighbouring images as red and blue. If you would 

now like to make changes to the weighting of a particular image, 

pay attention to the image’s colour and choose the respective 

colour in the paint symbol bar. 
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To clarify: The brush does not mean that you are painting colours 

directly onto the image, rather you are adjusting the brightness 

weighting in certain areas of individual images. For example, an 

HDR result shows a landscape where the exposure is correct every-

where except for the tree in the foreground, which is too dark. Here 

you can select the brightest image from the series and enhance the 

brightness of the tree by “painting” the object. The final fusion is a 

balanced image with a correctly lit tree in the foreground.    

 

Adjusted Weighting:  

After drawing, the adjusted weighting can be seen to the right of the 

individual image. The white 

drawn strokes mean that you 

have emphasised the tree in 

the brightest image and that 

the tree will be brighter in the 

HDR result.   
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The tree was selectively brightened, and this without altering the 

brightness of the sky, clouds or plains. The diffused brush makes 

the transitions invisible. The result is a properly weighted image with 

a correctly lit tree in the foreground. The well structured sky remains 

in the background.   

 

 Important tools of the HDR-Painter: 

 

 

 
Increase weighting: Draw on the selected area to enhance 

the weighting of this portion of the image. 

 
Reduce weighting: Draw on the selected area to reduce the 
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weighting of this portion of the image. 

 Brush size: Adjust the size of the brush. 

 

 

Brush form: With numerous new brushes, you will find the 

right from for your selected area.   

 
Stamp: The stamping mode not only edits the weighting of 

the current image but adjusts the weighting of all of the other 

exposures accordingly. For example, if you use the paint tool 

to increase the weighting of an area in one image, the 

weighting of that same section will be reduced in all of the 

other exposures to amplify the effect. 

 
Blurring: If you want soft transitions between corrected and 

original areas, trace the blurring function over the borders to 

soften the transitions. 

 HDR-image/ weighting: This function mixes the view be-

tween the HDR image and the weighting. This is very effective 

for maintaining control while drawing. 

 

 
Delete weighting: Delete the drawn weighting for the active 

image of the series.    

 
Delete all: Warning: This function deletes all of the drawn 

weightings and returns to the initial settings. 
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18. Ghosting Removal with HDR Painter 

When we manually adjust parts of images, it naturally has an effect 

on the program’s ghost image correction. Ghosting can occur when 

capturing a bracketing series of a scene where people or vehicles 

are in motion and thus captured at a different position in every shot. 

Without the automatic ghosting removal from HDR projects 7, the 

moving objects would appear at a different position in every image, 

thus causing a ghost-like effect.   

Manually removing ghosting:   

The following example illustrates how HDR painter can eliminate the 

regular problem of people walking through a bracketing series.   

Here is the example after being uploaded and without ghost remov-

al:   

 

 



HDR projects 7 – User manual 

 

139 

Looking at the image, the people on the left and right are immedi-

ately recognisable as ghost images.   

Let’s remove the ghosting as follows:  

1. Find the image in the series displayed on the left that 

comes closest to the brightness of the HDR image. This is 

usually the master image or one above/below.   

2. Select the button for the appropriate colour for this photo, 

and HDR projects 7 will allocate red to this image and au-

tomatically open the HDR drawing mode. 

 

 

3. Select the “Increase Weighting” function and activate 

stamping mode.    

 

 

4. Draw over the people by carefully dabbing with the brush. 
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5. Select the “Blurring” button and stamping mode.   

 

6. Carefully trace the edges of the correction with the blurring brush. 

Done!  

 

Switch to tone mapping and select the “Natural sharp” preset to see 

the result.    
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The ghosting has disappeared from the HDR image!  

 

Tip: “Dabbing” the brush is the optimal method for best results.   

If you would like the program to automatically remove ghosting or 

you have simply forgotten to activate the ghosting removal in the 

HDR preparation when loading the images, click on this button  

to start a new evaluation.   

 

Warning! A new evaluation eliminates all manually removed 

ghosting!   
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19. Workflow 

 Edit final image further in an external program 

HDR projects 7 offers interaction with external programs. This 

way you can take a successful HDR result to another photo ed-

iting program and continue there.   

 

 Open in other projects programs 

Click on the “Projects” symbol in the toolbar to open the image in a 

different program from the projects series. Use the drop-down menu 

beside the symbol to choose one of the programs that you already 

have installed on your computer. 

 

 

 Open in other photo-editing programs 

To directly open the image in another photo editing program, such 

as Adobe Photoshop, click on the corresponding button in the sym-

bol bar.   

If necessary, go through the 

settings to show the path to the 

program. Click on “Extras” in 

the menu and select “Settings” 

in the drop-down menu:  
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Next, click on the “Export” tab. You can enter the name of a photo 

editing program here, and save it for later as well.    

With the exception of Adobe, you have the option to rename the 

external editors. The name you assign will be displayed in the Quick 

Export menu in the toolbar of the main screen. 

 

 



HDR projects 7 – User manual 

 

144 

 Work with a Timeline and Restore Points 

This option can be found in the symbol bar at the top edge of the 

screen: 

 

“Create Restore Point” saves a virtual snapshot of the current set-

tings. You can now always return to this stage of your editing. You 

can save as many editing restore points as you like. The timeline 

displays the restore points and makes it possible to call up any 

phase of the editing process with just a single click:   

 

 

 

This function is especially useful when, for example, you are satis-

fied with an image, yet want to continue trying out different settings 

and effects. Simply set a restore point and carry on editing your 

picture. If you want to go back, simply click on your restore point in 

the timeline.    

If you click on  you can add your own note as a heading. 
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20. Selecting and Saving Sections of Images 

To save a final image, click on the button in the toolbar, go 

through the file menu or use the corresponding keyboard 

shortcut (Ctrl + S).   

 

 Cropping and captions 

As soon as you have initiated a file save, the cropping and caption 

window will open. If you would not like to crop or add a caption to 

your image, click continue.  

 

At the top are several practical aids for perfect image composition 

and cropping.   

You can set the aspect ratio and activate guidelines like the rule of 

thirds, the golden section or the golden spiral.  The new photo cen-

tre display is also quite practical which you can access by simply 

clicking on this button. 
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The centre of the window shows your final image. Fix the area to be 

saved by adjusting the corners and borders of the photo.   

At the bottom is an option to enter a caption. You can determine the 

size, position and background for the text. 

The size of the text will be automatically coordinated to the final 

cropping. 

You can either crop by hand or 

use one of the 71 provided 

formats.    

 

Please note: If you choose 

the cropping ratio 13 x 18, 

for example, the final image 

will not be saved as 13 x 18 

cm, rather as a ratio of 13 to 

18.    

 

You will also find the "Scale and Save" button at the bottom. With 

this option you can choose between 30 different templates for vari-

ous online platforms such as Facebook, Instagram, YouTube, etc. 

or simply specify your own scaling values (scaling in percent and 

resolution in pixels). 
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As soon as the image has been cropped and captioned, confirm the 

save and the following window will prompt you to select a file format 

and name your file.  
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21. Via GPS coordinates directly to Open-

StreetMaps 

If the GPS coordinates are in your Exif-files (Menu  Exif infor-

mation), then you will be able to locate the place where the photo 

was shot when you click on the button “Open GPS coordinates via 

Browser”. You will see the place the photo was shot in 

www.OpenStreetMaps.org. 

 

 

 

 

 

http://www.openstreetmaps.org/
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22. Keyboard Shortcuts 

Overview of the integrated Keyboard shortcuts 

In the main menu in the area of information you will find an over-

view of all available keyboard shortcuts.  

 

Click on this item to open the overview: 

 

In the overview you will be able to scroll through the different areas, 

where you can take shortcuts. 
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General: 

Windows Apple 

Ctrl N  cmd N New Project 

Ctrl Shift O  cmd Shift O  Upload Single Image 

Ctrl O cmd O Upload Image Sequence/Bracketed 

Series 

Ctrl S  cmd S  Save Image Result 

Ctrl D  cmd D  Print Image Result 

Shift Z  Shift Z  Create Undo-Point 

Ctrl T  cmd T  Open Timeline 

Ctrl F4 cmd F4 Quit Program  

F5 F5 Edit Image Sequence/Bracketed Series 

F6 F6 Edit Weighting 

F7 F7 Switch to Post Processing 

Ctrl P  cmd P  Open Settings 

@  Access Homepage 

Shift F1 Shift F1 Open About Dialogue 

Ctrl I Ctrl I Show Information Section 

Ctrl E  cmd E  Show Exif-Information 

Ctrl H  cmd H Show/Hide Histogram  

Ctrl F  cmd F Fullscreen Display 

 

 

Display Functions: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out  

Ctrl 0 cmd 0 Fit Image to Screen 

Ctrl 1 cmd 1 100% Display View 
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R  R Real-time Mode on/off 

L  L Configure Radar Window (lock) 

 

 

 

Progress Browser: 

Windows Apple 

Image up  Image up Back one page 

Image down Image down Forward one page 

Pos1 key Pos1 key  To the Beginning 

End key  End key  To the End 

Cursor left  Cursor left  Previous Item 

Cursor right  Cursor right  Next Item 

 

 

Variation Browser: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out  

Cursor left Cursor left  Shift View to the Left  

Cursor right Cursor right Shift View to the Right  

Cursor upwards Cursor upwards Shift View Upwards  

Cursor downwards Cursor downwards Shift View Downwards  

Ctrl  0 cmd 0 Show All  

Space Bar Space Bar Center View 

Enter Key Enter Key Select Item 

 

Weight Painter: 

Windows  Apple 
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1 1 Choose Red Brush Tool  

2 2 Choose Green Brush Tool  

3 3 Choose Blue Brush Tool  

Ö Ö Increase Brush Size  

# # Reduce Brush Size 

Ctrl G cmd G Calculate Automatic Ghosting Correction 

 

 

 

Sensitive Selective Painting: 

Windows  Apple 

Ctrl +  cmd + Zoom in 

Ctrl -  cmd -  Zoom out 

Ctrl O cmd O 100% Display View/Adjust Fit  

A  A Activate Brush Tool  

Shift A  Shift A  Activate Brush Tool with Limit 

S S Activate Eraser Tool 

Shift S  Shift S  Activate Eraser Tool with Limit 

W W Activate Blur Tool  

E  E Activate Image Mask Creator  

D  D Activate Fill Mode  

F  F Activate Brush Fill Mode  

R  R Activate Brush Streak Mode  

1 1 Reduce Brush Size 

2 2 Increase Brush Size 

3 3 Reduce Opacity  

4 4 Increase Opacity  

5 5 Soften Outline Recognition 

6 6 Sharpen Outline Recognition 
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7 7 Reduce Blur  

8 8 Increase Blur  

Ctrl  Z  cmd Z Back One Step   

M, Shift M  M, Shift M  Mask Display On/Off 

 

Scratch and Sensory Error Correction: 

Windows Apple 

Ctrl + cmd +  Zoom in 

Ctrl - cmd -  Zoom out  

 

Cursor left, Shift Cursor left, Ctrl Cursor left  Move Active Correction Region left  

Cursor right, Shift Cursor right, Ctrl Cursor  Shift Active Correction Region right 

right   

Cursor upwards, Shift Cursor upwards, Ctrl   Shift Active Correction Region upwards 

Cursor upwards  

Cursor downwards, Shift Cursor downwards, Shift Active Correction Region down-

wards  

Ctrl Cursor downwards 

Image up  Image up Select Previous Correction Region 

Image down  Image down Select Next Correction Region 

C  C Activate all Correction Regions 

N  N Set New Correction Region 

Entf  Entf Delete Correction Region  

+ + Enlarge Active Correction Region  

- - Minimize Active Correction Region  

 

Selective Editing: 

Windows  Apple 

Cursor left, Shift Cursor left, Ctrl Cursor Shift Selective Editing Region left  

Cursor right, Shift Cursor right,  Shift Selective Editing Region right 
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Ctrl Cursor right 

Cursor upwards, Shift Cursor upwards, Ctrl Cursor Shift Selective Editing Region 

upwards 

upwards 

Cursor downwards, Shift Cursor downwards,  Shift Selective Editing downwards 

Ctrl Cursor upwards 

Image up  Image up Select Previous Correction Region 

Image down  Image down Select Next Correction Region 

Entf Entf Delete Active Correction Region  

1 1 Hide All Masks 

2 2 Show Active Selective Editing Region 

Masks  

3 3 Show All Selective Editing Region Masks 

 

 

Image Cropping: 

Cursor left, Shift Cursor left, Ctrl Cursor left Shift Cropping Region to the left 

Cursor right, Shift Cursor right, Ctrl Cursor  Shift Cropping Region to the right 

right   

Cursor upwards, Shift Cursor upwards,  Shift Cropping Region upwards 

Ctrl Cursor upwards  

Cursor downwards, Shift Cursor downwards, Shift Cropping Region downwards 

Ctrl Cursor downwards 
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23. Integrated list of supported RAW formats 

In the main menu in the area information you will find an integrated 

list of supporting camera RAW-formats sorted by manufacturer.  

 

If you chose this menu item a camera RAW-format window will 

open. 

 

In the top area of the window you will find a selection of choices, 

with which you will be able to filter the list for singular camera manu-

facturers. This way you will find your camera faster. To have con-

stant access to the supporting camera RAW- formats via a separate 

window, you can use the function „open in browser“(window bottom 

left), which will show the list in a standard browser. You will also be 

able to print the supporting RAW-formats from there. 
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